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•	 Recording	in	Camtasia

•	 Saving	Projects	Editing	
Projects

•	 Adding	Enhancements

•	 Produce	and	Share	to	
YouTube

More than a simple screen recorder, Camtasia helps you create 
professional videos easily. Use Camtasia to record on-screen 
activity, customize and edit content, add interactive elements, and 
share your videos with anyone, on nearly any device.
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Your goal is to create an effective and professional Camtasia production.  Be sure to 
keep in mind some simple setup tips that will help you achieve this.  

•	 Make	sure	your	desktop	is	not	distracting
•	 Create	a	script	prior	to	recording
•	 Do	a	practice	run-through
•	 Use	proper	equipment	for	recording

Preparation For Recording

Preparation For Recording

•	 Change your desktop background to have as few bright colors as 
possible.  If you upload your video and use closed captioning, it 
may be difficult to see the captions.

•	 You should remove any icons from your desktop that you will not 
be using.  Create a temporary folder to move them into.  They can 
be moved back after recording.

Make Sure Your Desktop is not Distracting

A script allows you to organize what you will say and when you will 
say it.  It also will allow you to know when to change your focus from 
one application to another.  This can be accomplished by using two 
columns in your script.

Create a Script Prior to Recording

Be sure to practice your script along with actions on your computer 
before recording.  Getting comfortable will ensure fewer mistakes.

Do a Practice Run-Through

A USB headset proves to be the most effective type to use.  Also, be 
aware of your surroundings.  Air conditioners and closing doors will 
be heard in your productions.

Use Proper Equipment for Recording
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Recording Your Desktop

1. Open Camtasia Studio by double-clicking the Camtasia Studio
 8 desktop icon.

2. The Camtasia editor will open.  
 Click the Record the Screen
 menu item. 

Launch Camtasia

3. The Camtasia screen recorder will appear.   Camtasia Studio will minimize to the task bar. 

Select area
•	 Gives the option to record the screen at full screen or a custom screen area

Recorded inputs
•	 Gives the option to record a Webcam and/or Audio 

Recorded
•	 Begin Recording
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1. Choose Full Screen to record your 
 entire desktop.

2. To select a custom size, click the 
 Custom menu option.  From here you 
 can choose screen size aspects.

 You can also Select an area to record.   

Recording Your Desktop

Set Screen Area

Note: The green dashes indicate
 the recording area.

Set your screen recording area by following these few steps.
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1. To enable audio recording, click the Audio Off button on the Camtasia Recorder menu.  The 
 button will change to an Audio On button.  To disable audio, click the Audio On button.

Set Recorded Inputs
Recorded inputs can be system audio or your own recorded voice.  To record audio for your Camtasia 
production, follow these few steps.

Note: A USB headset with microphone 
 will provide the best recording 
	 quality.

2. Click the drop-down menu next to the Audio On button to customize your settings.  Make
 sure the correct microphone option is set.  You can also set your system audio recording 
 preference.

Select audio input

Record System Audio

Recording Your Desktop

3. Speak into your microphone at the same level you will 
 record.  Slide the volume level left or right until the 
 recording level is a yellow color.  

Note: Have you followed all of the preparation 
 steps on page 3?



7

The Office of Academic Affairs

     Fall 2013Academic Affairs 241-6423

Recording Your Desktop

Record the Screen
Once you are set up, you can begin recording.  If you are going to record any applications on your 
screen, be sure to open them first.

1. To begin recording, click the red Rec button on the Camtasia recording menu.  Or press the
 F9 hot key on the keyboard.

2. You will see a countdown.  Once the countdown goes away, you are recording. 

3. To end recording, click the Camtasia recording menu from the task bar and click the Stop
 button.  Or you can easily press the F10 hot key on the keyboard.

Note: Hot Keys can be configured in 
 Options under the Tools menu.
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Recording Your Desktop

The Preview Window
Once you stop recording the Preview window will appear.  You have the option to view the preview for 
mistakes.  You can save for editing now or save the file to edit later.  You can also produce or delete 
the recording. 

1. Once you are finished previewing the video, click
 the drop-down box under Save and Edit.  Choose 
 Save As. 

2. Browse to the location to save your
 recording file.  Click the Save 
 button.

Note: Create a new folder for each 
 project.  If you are creating multiple 
 recordings for one project, store them
  in the same folder.

Saving Your Recording
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Recording PowerPoint

Launch PowerPoint
When you install Camtasia, an add-in is created in PowerPoint which will allow you to launch the 
Camtasia recorder from PowerPoint.  PowerPoint can be launched from within Camtasia Studio or 
from your desktop icon.

1. To prepare for recording, open Microsoft PowerPoint by double-clicking on the icon on your
 desktop or in the Start Menu.

Note: Only launch PowerPoint from within
 Camtasia Studio if you are working on 
 an existing project.

1. Open your PowerPoint presentation first.  Then click the Add-Ins tab.  

Record Audio
•	 Records your Audio.  (Configure Settings for system audio and Microphone audio.

Record Webcam
•	 Records your Webcam input. 

View Webcam Preview
•	 The Webcam Preview window will not be recorded along with the PowerPoint recording.

Recording Options
•	 Configure program, audio and video, Picture in Picture, and Hotkey options.

Camtasia PowerPoint Toolbar

1

2

3

4
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Hotkey Options

PIP Options

Video and Audio 
Options

Program Options

1. Click the Recording Options button to configure your
 recording options.  Click the OK button to close the options.

Recording PowerPoint

Set Recording Options

Note: Most of the settings can be left as  
 default. Make sure your Audio 
 source is set  to where your micro
 phone is plugged in.  You can also 
 choose to record system audio.

Note: Have you followed all of the preparation 
 steps on page 3?
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Note: Your screen recording resolution 
 is important.  If you are uploading 
 to YouTube, be sure to use 
 1280 x 720 screen resolution. This 
 can be changed by right-clicking 
 your desktop and choosing Screen 
 Resolution”.

Recording PowerPoint

Recording the PowerPoint Slideshow

1. To begin recording, click the red Record button on the 
 Camtasia PowerPoint toolbar.

2. Click the Click to Begin Recording 
 button to start the PowerPoint recorder.

3. Continue recording the PowerPoint until
 the end of the slideshow.  To end screen
 recording, click the Stop Recording
 button.

Note: You can pause the recording or stop it at any time by using
 Hotkeys.  Program your hot keys in the Camtasia Power
 Point options.
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1. Browse to the location to save your recording file.  
 Click the Save button.

Recording PowerPoint

Saving Your Recording

Note: You can choose to produce your
 recording or edit it immediately in 
 Camtasia Studio. You can also click 
 the Cancel button to edit later.

2. (OPTIONAL)

Note: Create a new folder for each project.  If 
 you are creating multiple recordings 
 for one project, store them  in the same 
 folder.

Camtasia screen and PowerPoint slideshow recordings are saved as .camrec files.  Camtasia studio 
is used to import, edit, and produce these file types.  You can also import other video file types into 
Camtasia Studio.  You can then create a production to be uploaded to YouTube.

Camtasia Studio Projects

1. Open Camtasia Studio by double-clicking the Camtasia Studio
 8 desktop icon.

Launch Camtasia
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Camtasia Studio Interface

Camtasia Studio Editor

1

5

3

6

2

4

1. Access to Record the Screen, Import Media, and Produce and Share.  

2. The Clip Bin holds all video, audio, and image files associated with the production.  This is also 
considered the Home area. 

3. The TimeLine holds all video, audio, and image clips in the order that the user wants them viewed.  
Edits to the production are made in the TimeLine.

4. The Camtasia Menu Bar allow the user to access all controls for the program.

5. The Camtasia Studio ribbon allows the user to edit the production by selecting each tab.  Enhance-
ments, special effects, or edits to the production are made through these tabs.

6. The Canvas is a preview window which allows you to see changes as they are made.
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Note: All source files for a Camtasia Studio
 project should be stored in the same 
 folder.

Importing media in Camtasia Studio can be done by using the Import Media tool or by adding another 
recording by using the Record the Screen tool.

Import Media

1. Click the Import Media button and browse to the location of your files.  Select one or more
 files. Then click the Open button in the explorer window.

2. (OPTIONAL)  Follow the steps starting on Page 4 to add a
 screen recording.  Follow the steps on Page 9 to add a Power
 Point recording.

After using the Import Media or Record the Screen tools, your media will appear in the Clip Bin.  The 
Clip Bin is also considered the Home Area.  The Clip Bin will house many of the types of media that 
you will use.  

Clip Bin

Note: Adding files to the Clip Bin does not
 automatically add them to the Time
 Line.

1. Right-click a Clip Bin item to view the item’s 
 options.

Camtasia Studio Editor
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After using the Import Media or Record the Screen tools, your media will appear in the Clip Bin.  The 
Clip Bin is also considered the Home Area.  The Clip Bin will house many of the types of media that 
you will use.  

The TimeLine

Add Items to the TimeLine
1. Right-click on the item to add to the TimeLine.  
 Choose Add to TimeLine at PlayerHead.

2. Set your item’s dimensions and background color of the canvas.  

3. Your item will appear on the timeline.  Repeat steps 1-3 for each item to add.

Note: Always plan ahead on how you 
 will deliver your videos to your
 videos.  If hosting them on 
 YouTube, choose the YouTube
 editing dimension.  If you are 
 hosting them on your own site,
 it is a good idea to not size the 
 video over 640 x 480.

7

3

5

1

6

2

4

Camtasia Studio Editor
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Camtasia Studio Editor

Zoom allows the user to zoom in or out of an area on the 
Timeline.

Editing tools allow the user to undo, redo, cut, split, copy, 
or paste in the Timeline.

Hide or Show Views allow the user to see the Marker 
View.

The PlayerHead not only shows your position in 
the Timeline, but also allow the user to make edits to the 
item selected.

Note: See Locking a Track for
 information on how to 
 restrict which tracks are 
 edited.

Insert Track allows the user to insert tracks for adding 
additional clips to the Timeline 

Lock Track allows the user to lock a track to prevent any 
Timeline changes from taking place to that individual track.

Adjust Track Heights allows the user to adjust all track 
heights to their preference.

TimeLine Functions
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Camtasia Studio Editor

Resizing Items
Before making any other edits to your video production, be sure to get the canvas size the right size for 
where it will be hosted.  YouTube is normally the desired place to host.  If you are using a Wide Screen 
format monitor there will be little manual resizing of videos.  If you are using a standard size monitor, 
you may have to manually resize your video.

1. To set your video to the appropriate size for YouTube viewing, click the Editing 
	 Dimensions button at the top left corner of the canvas. 

2. Click the drop-down box under 
 Dimensions and choose 1280 x 720
 YouTube and ScreenCast. Click the 
 OK button.  You can also change the 
 background color.

3.	 Drag	the	corners	of	the	screen	capture	until	they	fill	the	backdrop.		This	may	take	a	couple	of	
 attempts.

Note: You should resize each item
 added to the TimeLine from
 the Clip Bin for consistency.

Note: You can change the
 screen settings at
 any time.
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Camtasia Studio Editor

TimeLine Zoom
1. To zoom in on a certain area of the Timeline, use the slide.  Ctrl + will zoom in and Ctrl - will 
 zoom out also.

Markers
1. Markers can be used if you are going to keep track of a certain section of your video.  Markers  
 can also be used as a table of contents (cannot be used in videos uploaded to YouTube).

Inserting or Removing a Track

Note: Markers are automatically
 created when recording
 PowerPoint.

1. To insert a new track for an item, click the Add New Track Item.  To remove a track, 
 right-click the track and choose Remove track.

Note: Create a new track for
 video tracks and 
 enhancements.
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Locking a Track

1. To lock a track, click the Lock or Unlock Track icon.  Gray and white lines appear in the
 track to indicate it is locked. To unlock the track, click the icon again.

Although many edits can be singled to a specific item on the Timeline, be sure to lock any track that 
you don’t want changes to take place on.

Editing a Track

1. To remove a track, right-click the track to remove.  From the drop-down menu, choose 
 Delete.

Many edits can be made to a track.  You can split a track.  You can also cut, copy, or paste track items.

Note: You should save your work often.

Removing Items From a Track
You can remove all of an item from a track.

Camtasia Studio Editor

1. To rename a track, right-click on
 the track name, and choose rename
 track.

Renaming a Track
To stay organized, rename your track according to what part of the production they are.
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Note: Use your Zoom tool to make 
 accurate changes to your track 
 items.

1. Locate the area to edit with the PlayerHead.  
 Right-click on an area to split.  To split multiple
 tracks, select Split all.

Editing Items on a Track
You can make edits to specific items on a track by using the PlayerHead.

2. Locate the area to edit with the PlayerHead.  With a left mouse click select either the red or
	 green	tab	on	the	PlayerHead.		Drag	to	the	desired	area	to	edit.		Right-click the selected area  
 and choose your edit options.

Camtasia Studio Editor

Note: To undo changes made, click the Undo button on
 the Camtasia Studio editor.
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Camtasia Studio Editor

Callouts
A Callout can focus the viewer’s attention on a certain area of the video.  Use the following steps to 
add a callout.

1. Click the Callouts tab on the Camtasia Studio 
 ribbon.

Shape

Callout Length

Preview

Fade Options

Text Editor

Text Options

Callout Options

Note: Create a new track
 for all callouts.

2. Select your callout.



22

The Office of Academic Affairs

     Fall 2013Academic Affairs 241-6423

Camtasia Studio Editor

2. To flip a Callout, click the Effects button and select Flip
 from the drop-down.

3. To resize a Callout, on the Canvas place your mouse on a 
 corner of the callout.  Left-click and drag the Callout to the 
 desired size. 

4. To rotate a Callout, on the Canvas place your mouse in the 
 center of the Callout until the green circle appears in the 
	 center.		Drag	the	mouse	in	the	direction	to	rotate	the	Callout.

5. To adjust the Callout duration, place the 
 PlayerHead on the desired start or end of the 
 Callout on the Timeline.  Then drag the left and/or 
 right side of the Callout on the Timeline to match 
 the Player Head position.

Note: Use your Zoom tool to make 
 accurate changes to your track 
 items.
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Camtasia Studio Editor

Zoom-n-Pan
Zooming in a an area of the video allows the viewer to focus on that particular section.  To use the 
zoom tool, simply view your video up to the point to zoom in.  Zoom in the desired amount.  Continue 
viewing the clip.  When you are ready to have the video zoom out, adjust the zoom back out. 

1. Click the Zoom-n-Pan tab on the Camtasia 
 Studio ribbon.

2. Use either the PlayerHead on the
 Timeline or on the Canvas to set the 
 video section to be zoomed on.

3.	 Drag	the	corners	of	the	video	in	the	Zoom-n-Pan	window	to	zoom	in	on	the	object.

Note: Select Maintain
 Aspect Ratio.
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Camtasia Studio Editor

5. To zoom out, drag the corners of the
 video in the Zoom-n-Pan window back to 
 full screen size.

4. Play the video zoomed in up to the point to no longer zoom.

Audio
Be sure to check your microphone levels before recording PowerPoint or the desktop.  Sometimes you 
may need to even out the levels of the audio, or even mute some unwanted sounds. 

1. Click the Audio tab on the Camtasia Studio 
 ribbon.
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Note: The Audio tab affects all
 tracks.  If you do not 
 wish to have a track’s 
 volume edited, lock the 
 track.

2. Select the audio properties for all tracks by checking the properties boxes.  Advanced settings 
 are available.

Volume Leveling/
Variation

Remove Mouse Clicks

Noise Removal

3. Make changes to the entire audio track by using the editing tools.

Volume

Fade

Silence

Camtasia Studio Editor
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4. Make changes to specific points on the audio track by using the editing tools.

Note: The Silence Editing tool can save you a lot of
 time by silencing mistakes such as coughs.

Transitions
Add a transition between different video segments to enhance your video.  You can add a transition 
anywhere that has a break in the video.  If there is no break where you want a transition, add a split to 
the video track.

1. Click the Transitions tab on the Camtasia 
 Studio ribbon.

2. Select the track to add
 a transition to.

3. Right-click the transition you wish to use.  Select
 Add to Selected Media.  Your transition will 
 appear on the Timeline.
 You can also drag and drop the transition where you 
 want it.

4. (OPTIONAL)  You can also drag the transition lengths on the Timeline to be longer or 
 shorter on start and finish.

Camtasia Studio Editor
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Voice Narration
It may be necessary to narrate y0ur track after it’s been recorded.  Voice Narration can be added to 
any track anywhere in the Timeline.

1. Click the Voice Narration tab on the 
 Camtasia Studio ribbon.

2. In the Voice Narration area, test your
 microphone.  Click the Audio setup 
 wizard if your audio isn’t functioning 
 properly.

3. Verify your audio settings.  Click the Next button.  Camtasia Studio will also help you to 
 adjust your recording volume.  Click the Finish button.

Note: Muting your speakers during 
 recording reduces feedback.

Camtasia Studio Editor
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Note: Create a new track on the 
 Timeline to record the 
 Voice Narration to.

4. Position the PlayerHead on the Timeline where you want to 
 add voice narration.  Click the Start recording button.
 Your recording will begin immediately.  

5. Click the Stop recording button and save your file.

Note: Save your audio file in the 
 same location as the rest of 
 your project files.

6. Your voice narration will appear on the timeline.

Camtasia Studio Editor
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Record Camera
A webcam recording can be added to any track anywhere in the Timeline.  Camtasia Studio allows a 
floating webcam video to be added to any area of the screen.

1. Click the Record Camera tab on the 
 Camtasia Studio ribbon.

2. Verify your webcam is showing video.
 Check your audio settings.  (Refer to
 page 28).  Click the Start recording 
 button. Your recording will begin 
 immediately.  

3. Position the PlayerHead on the Timeline where you want to add your camera recording. Click
 the Start recording button.  Your recording will begin immediately.  

Note: Create a new track on the 
 Timeline to record the 
 Camera Recording to.

4. Click the Stop recording button and save your file.

Camtasia Studio Editor



30

The Office of Academic Affairs

     Fall 2013Academic Affairs 241-6423

5. Your Camera recording will appear on the timeline.

6. By default the Camera recording appears in the center of the canvas.  You can move the 
 Camera recording to another place on the canvas if you wish by using the left-click on the
 mouse and drag-and-drop.

Camtasia Studio Editor



31

The Office of Academic Affairs

     Fall 2013Academic Affairs 241-6423

Captions
To	ensure	that	your	online	video	is	ADA	compliant,	captions	must	be	available	to	viewers.		Camtasia	
Studio can translate your voice from any video source on the Timeline.  The translation is not perfect 
and there will be edits that will have to be made.  

1. Click the Captions tab on the Camtasia 
 Studio ribbon.

2. You can manually type your captions,
 or you can use Speech-to-text.  Click
 the Speech-to-text button.

3. Select “Entire Timeline” from the 
 Speech-To-Text window.  

4. Click the Continue button on the
 next screen.  

Camtasia Studio Editor
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5. Once the progress meter finishes, your captions will
 appear on the Timeline.

6. Make any corrections to your captions that are necessary.  Compare your captions to your 
 script to make sure they match.

Camtasia Studio Editor
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Editing Captions
Captions should be accurate.  Having a script in advance makes editing captions much easier.  To 
edit your captions, listen to each clip the caption creates.  Simply make sure the words match the text.  
Make any corrections to your captions that are necessary.  Compare your captions to your script to 
make sure they match.

1. To proof your caption, double-click the caption area on the Timeline.  Then press the Enter
 Key on the keyboard.  The audio will play.  Make sure the words on the caption editor match 
 what you hear. 

Exporting Captions
You may want to export your captions to upload to Blackboard Learn as an attachment for your video.

1. Click the Export captions button in the Captions editor window under Advanced. 

2. Browse to the location to save
 the .srt file.  Click the Save 
 button.

3. Use Windows Explorer.  Navigate to the file you exported.  Right-click the file name and
 change the .srt to .txt.  Click the Yes button on the Rename box. 

Camtasia Studio Editor
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Produce and Share
Your final production can be produced in many formats.  The shared location will more than likely be 
YouTube. 

1. Click the Produce and Share button on
 the Camtasia toolbar.

2. Click the drop-down box on the Camtasia 
 Studio Production Wizard screen and
 choose Share to YouTube.

3. Click the OK button on the next screen.

4. Enter your YouTube credentials and click the Next button.  Enter the video settings in the
 next window.

Note: Check the Upload Captions
 box.

5. When the progress window reaches 100%, 
 YouTube will open and process your video.  

Camtasia Studio Editor

Note: It will take some time for 
 the YouTube video to be 
 available.

Note: Set Privacy to “Public” for 
 Blackboard Learn to find 
 the YouTube video.
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Camtasia Studio Editor

Save Project File
You may refer back to a video to make changes later.  Your Camtasia Studio project file (.camproj) 
contains all edits made to your project on the Timeline.  If you remove the files from the folder where 
they are stored, Camtasia Studio will not be able to reference them later. 

1. Click the File menu at the top left corner of the screen. 
 Choose Save Project from the menu.  

2. Browse to the location of your project files.  Give the 
 project file name a meaningful name.  Click the Save 
 button when finished.

3. Click the OK button on the Camtasia Studio pop-up box.
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